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1.	 Einführung
Danke für den Kauf von NTi Audio‘s MiniLINK, einem Produkt zur 
Dokumentation von Messdaten des Minilyzer ML1, des Digilyzer DL1 
und Acoustilyzer AL1 (siehe hierzu das spezielle AL1 Handbuch). Diese 
Anleitung beschreibt die PC Software „MiniLINK“ und ergänzt zugleich die 
bestehenden Handbücher des Minilyzer bzw. Digilyzer. 
Zusätzliche Informationen über  die handlichen Audiomessgeräte Minilyzer 
und Digilyzer finden Sie in den entsprechenden Anleitungen oder auf 
unserer Webseite www.nti-audio.com.

Lieferumfang:
	 1x	 MiniLINK USB Karte
	 1x	 Batteriedeckel für Minilyzer ML1 (schwarz)
	 1x 	 Batteriedeckel für Digilyzer DL1 (blau)
	 1x 	 USB Kabel
	 1x 	 MiniLINK Handbuch

Registrieren Sie Ihr Messgerät hier und laden die MiniLINK-Software 
herunter https://my.nti-audio.com.

CE Konformitätserklärung

Der Hersteller		  NTi Audio AG, Im alten Riet 102, 9494 Schaan
			   Liechtenstein, Europa

erklärt hiermit, dass das Produkt MiniLINK, Konstruktionsjahr 2003, 
folgenden Standards genügt:

EMC:			   89/336, 92/31, 93/68
Standards:		  EN 61326-1

Diese Deklaration wird ungültig, sobald ohne schriftliche Genehmigung von 
NTi Audio irgendwelche Änderungen am Gerät vorgenommen werden. 

Datum:			   01.07.2003

Unterschrift:		  	
Position:		  Technischer Direktor:			 

https://my.nti-audio.com
https://my.nti-audio.com
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Internationale Garantie und Reparatur

Internationale Garantie
NTi Audio garantiert die einwandfreie Funktion von MiniLINK für ein Jahr 
ab dem Verkaufsdatum. In dieser Periode werden defekte MiniLINK USB 
Schnittstellen kostenlos repariert oder ausgetauscht.

Achtung
Die Verwendung einer MiniLINK USB Karte für mehrere Messgeräte ist 
nicht gestattet. Nach dem Einbau der MiniLINK USB Karte in einen Minilyzer 
oder Digilyzer darf die USB Karte nicht mehr herausgenommen und in ein 
anderes Messgerät eingebaut werden. Jegliche Zuwiderhandlungen sind 
setzen diese Garantiebestimmungen ausser Kraft.

Einschränkungen
Diese Garantiebestimmung erstrecken sich nicht auf Schäden, die durch 
Unfälle, Transport, falsche Verwendung, Unachtsamkeit, durch Zubehör 
bzw. Einbau von Teilen die nicht zum Gerät geliefert wurden, den Verlust von 
Teilen, den Anschluss an Netzspannung, den Betrieb mit nicht spezifizierten 
Eingangsspannungen, Adaptertypen oder falsch eingelegte Batterien 
verursacht wurden. Im speziellen lehnt NTi Audio jegliche Verantwortung 
für Folgeschäden ab.

Die Garantie verfällt bei der Durchführung von Reparaturen oder 
Wartung durch Dritte, die nicht Teil eines bevollmächtigten NTi Audio 
Wartungszentrums sind.

Reparatur von MiniLINK
Im Falle einer Fehlfunktion oder eines Schadens, senden Sie den NTi Audio 
Minilyzer oder Digilyzer mit MiniLINK, verpackt in der Originalschachtel, 
zu Ihrer nächsten NTi Audio Vertretung. Bitte legen Sie eine genaue 
Fehlerbeschreibung bei. Die Kontaktadressen finden Sie auf der NTi Audio 
Webseite www.nti-audio.com.

Garantiereparaturen bzw. -austausch werden nur gegen Vorlage des  
Originalverkaufsbelegs durchgeführt.

https://my.nti-audio.com


6

Wichtige Hinweise

Das MiniLINK USB Modul ist für die fixe Montage in einem ML1 
oder DL1 vorgesehen. Es darf nicht von einem Gerät in ein 
anderes umgesteckt werden, da dabei die Steckverbindung im 
Gerät beschädigt werden kann.

Durch die USB Schnittstelle ist die Masse Ihres ML1/DL1 mit der 
Erdung des PC verbunden, d.h. Pin1 des XLR Steckers sowie der 
Masseanschluss der RCA Buchse sind geerdet.

Bitte berücksichtigen Sie unbedingt diese Erdverbindung bei 
Messungen an Leistungsausgängen, da hier eine falsche 
Beschaltung die Beschädigung des Prüflings oder des Messgerätes 
zur Folge haben kann! 

Verwenden Sie in solchen Fällen den Pin1 des ML1 nicht, 
sondern messen Sie immer (auch bei unsymmetrischen Signalen) 
nur über Pin2 und Pin3, oder stecken Sie das USB Kabel aus, d.h. 
der Leistungsausgang des Verstärkers darf nur an Pin2 und Pin3, 
des ML1 XLR Eingangssteckers, angeschlossen werden. Der 
RCA Eingang darf nicht verwendet werden.

Wir empfehlen außerdem, sensible Messungen wie z.B. von 
Signalen mit kleinen Pegeln oder guten THD+N Werten „offline“ 
durchzuführen, d.h. bei abgestecktem USB Kabel. Die Messwerte 
können dabei im Gerät abgespeichert und anschließend zum PC 
übertragen werden.

Beim Einbau der MiniLINK USB Schnittstelle sind die allgemeinen 
ESD Schutzmassnahmen zu beachten.
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2.	 Installation

Einbau der MiniLINK USB Karte

Bitte folgen Sie genau den einzelnen Anweisungsschritten.

a. Vorbereitung

Stecker

Ziehen Sie den Batteriedeckel 
vom Messgerät und entfernen  
Sie die Batterien.

b. ESD Massnahme

Nehmen Sie die MiniLINK 
PCB aus der ESD Tasche.

Vor der Installation der 
MiniLINK USB-Schnittstelle 
müssen jegliche statische 
Spannungen ausgeglichen 
werden. 

Hierzu berühren Sie  
während der Installation 
mit den Fingern den 
unteren, linken Batterie- 
kontakt.
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c. USB Karte positionieren

Platzieren Sie die USB-
Schnittstelle auf die linke Sei-
tenfläche des Batteriefachs.

d. USB Karte einführen

vorderer Teil muss einrasten

Führen Sie die USB Karte 
vorsichtig ein, so dass der 
vorderste Teil beim Stecker 
unter dem Gehäuseabsatz 
einrastet.
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e. USB Karte einstecken

parallel hinunter drücken obere 
Gehäuse- 
kante

Stecker

Drücken Sie die USB Karte 
nun vorsichtig auf den 
Stecker, welcher sich auf der  
linken Seite des  Batteriefachs 
befindet.

Nach dem Einbau muss die 
obere Gehäusekante des 
Batteriefaches sichtbar sein. 
Nur dann ist die USB Karte 
richtig auf den Stecker mon-
tiert.

f. Schutzkleber abziehen

hintere, längere Schutzkleberlasche 
nach oben ziehen

gleichzeitig USB Karte am 
Montagestecker festhalten

Entfernen Sie den Schutzauf-
kleber von der Rückseite 
der USB Karte. Halten Sie 
die USB Karte am Montage-
stecker fest in Position und 
ziehen Sie gleichzeitig die 
hintere, längere Schutzkle-
berlasche nach oben.
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g. USB Karte andrücken

Drücken Sie die USB Karte 
seitlich leicht gegen das 
Batteriefach, sodass die 
USB Karte gut befestigt am 
Batteriefach klebt.

Nun ist die USB Karte fix am 
Messgerät montiert und darf 
nicht mehr entfernt werden.

h. Batteriefach aufschieben

Batteriefach 
aufschieben

Legen Sie wieder die 
Batterien ein und schieben 
Sie den neuen Batteriedeckel 
auf das Messgerät. Die 
zusätzliche Öffnung auf der 
Seite muss genau über den 
USB Stecker passen.

i. Endkontrolle

         

Die USB Schnittstelle ist 
jetzt fertig eingebaut und das 
Messgerät wieder betriebs-
bereit.
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MiniLINK PC Software Installation

a.	 PC mit Windows Betriebssystem einschalten (MiniLINK V3.00 oder 
höher unterstützt Windows XP, 7, 8 oder 10 (32 & 64 Bit)).

b.	 Registrieren Sie Ihr Messgerät hier und laden die MiniLINK-Software 
herunter https://my.nti-audio.com.

c.	 Installieren Sie die MiniLINK-Software.

d.	 Verbinden Sie das Messgerät mit den PC über das beiliegende USB 
Kabel. Windows erkennt daraufhin diese neue Hardwarekomponente 
und startet den Assistenten zur Geräteinstallation.

e.	 Die Warnmeldung “Digitale Signatur nicht gefunden” wird angezeigt. 
Bestätigen Sie diese und setzen die Installation fort.

https://my.nti-audio.com
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Starten der MiniLINK PC Software

Nach erfolgreicher Installation des Treibers kann die MiniLINK PC Software 
bei angestecktem Messgerät gestartet werden.

a.	 Starten Sie MiniLINK mittels Windowsmenüpfad “Start -> Programm -> 
MiniLINK”. 

b.	 Das Messgerät schaltet sich automatisch ein und die folgende 
Information erscheint:

c.	 Die Software überprüft die Firmware Version des Messgerätes und 
schlägt - sofern erforderlich - eine automatische Aktualisierung vor.
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Neue Firmware laden  

Die MiniLINK Software überprüft die Firmware Version des angeschlossenen 
Messgerätes und schlägt - sofern erforderlich - eine automatische 
Aktualisierung vor:

Bestätigen Sie die Auswahlbox mit „Update Instrument Firmware“ und 
selektieren Sie im folgenden Fenster die Firmwareversion

für Minilyzer ML1:
ML1dA_V3.xx.hex

für Digilyzer DL1:
DL1eD_D2.xx.hex

die verfügbare 
Firmware für das 
angeschlossene 
Messgerät wird 
angezeigt

Nach Bestätigung der Softwareversion wird das angeschlossene Messgerät 
aktualisiert. 

Alternativ kann die Firmware auch über den Menüpunkt „Tools -> Update 
Firmware“ durchgeführt werden. 

Hinweis:	 Tritt während des Aktualisierens der Firmware ein Fehler 
auf (z.B. Stromausfall), so kann der Vorgang jederzeit 
wiederholt werden.
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Kostenlose Messgeräteregistrierung

Die neue Firmware enthält „Bonusfunktionen“, die Sie nur durch die 
Registrierung des entsprechende Gerätes freischalten können.

Übersicht der verfügbaren Bonusfunktionen:

� Messgerät Funktion Anzeige
ML1 Loggen von SPL/

LEQ Ergebnissen 
mittels zusätzlichem 
Speichermenüpunkt „LOG 
AS xxx_LOGSPL“

ML1 
AL1
DL1 

Anpassbarer Startbildschirm

Online Registrierung:
Schliessen Sie das Messgerät an den PC an, starten die MiniLINK 
Software und folgen der automatischen Registrierungsmeldung. Alternativ 
kann die Registrierung unter dem Menüpunkt „Help -> Register“ ausgeführt 
werden.

Offline Registrierung:
Alternativ registrieren Sie Ihr Gerät auf der NTi Audio Webseite  
http://my.nti-audio.com mittels Eingabe Ihrer Kontaktdaten und der 
Geräteseriennummer (diese kann an der Startanzeige abgelesen werden). 
Während des Einschaltens muss eine beliebige Taste zur längeren Ansicht 
der Startanzeige gedrückt werden. Die Seriennummer beginnt mit drei 
Buchstaben (z.B. ANK675A0A2).

Nach erfolgreicher Registrierung erhalten Sie einen Schlüsselcode per 
E-mail zugesendet, den Sie im Menüpunkt „Help -> Register“ eingeben 
können. Bitte beachten Sie, dass dabei das entsprechende Messgerät an 
den PC angeschlossen sein muss.
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3.	 Neue Firmware für ML1 & DL1 
Die mitgelieferte ML1 bzw. DL1 Firmware umfasst eine Reihe neuer 
Funktionen, beginnend mit folgenden Firmwareversionen:
 
		  Minilyzer	 Firmware V3.00
 		  Digilyzer	 Firmware D2.00

Das zentrale Element ist die Speicherfunktionalität. Im folgenden 
Abschnitt werden alle Änderungen gegenüber den aktuellen ML1/DL1 
Produkthandbüchern beschrieben. Bitte beachten Sie, dass alle neuen 
Funktionalitäten anhand des Minilyzer ML1 beschrieben werden.

Speicherfunktion
       
    

neue MEM (=Speicher) Funktion

Menüauswahl

Die Menüauswahl beinhaltet neu die Speicherfunktion (MEM). Damit 
können Screenshots jeder beliebigen Anzeige im internen Gerätespeicher 
abgelegt werden. Bei Funktionen, die eine größere Zahl von Messwerten 
umfassen, wie 1/3rd OCT. Spektrum und Frequenzgang, werden zusätzlich 
die einzelnen Messdaten als Tabelle hinterlegt.
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Alle gespeicherten Messungen werden automatisch und eindeutig  mit 
einem Filenamen, bestehend aus der Messfunktion und einer fortlaufenden 
Nummer benannt („xxx“ = 3-stellige Nummer von 001 - 999, danach wieder 
mit 001 beginnend):

•	 ML1: „Mxxx_Messfunktion“, z.B. M075_Balance, M076_LOGSPL

•	 DL1: „Dxxx_Messfunktion“

Hinweis:	 Alle Speicherplätze bleiben auch bei entladenen oder 
entfernten Batterien über mehrere Jahre erhalten.

a. Speichern der Messergebnisse

Screenshot & Messwerte speichern:
• MEM Menü öffnen
• Enter drücken

Jeder gespeicherten Messung wird 
eine fortlaufende Nummer und die 
entsprechende Messfunktion als 
Speichername automatisch zugeordnet.

Maximaler Speicherplatz:
• Minilyzer ML1	39 Screenshots
• Digilyzer DL1	 78 Screenshots
(ohne numerischen Daten)

Wenn der Speicher voll ist, wird „CANNOT 
STORE: MEMORY FULL“ (=Speicherplatz 
voll) angezeigt.

b. Speicher anschauen und verwalten

Speicherübersicht aufrufen
In der Speicherübersicht können alle 
gespeicherten Messungen geprüft und 
verwaltet werden:
• MEM Menü öffnen
• VIEW/DELETE wählen
• Enter drücken
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Gespeicherte Testresultate
Die gespeicherten Messergebnisse sind 
nach der zeitlichen Abspeicherung von 
oben nach unten geordnet. Die letzte 
Messung ist immer am Anfang der Liste.

Der freie Speicherplatz wird in der rechten 
oberen Ecke dargestellt

Gespeicherte Messungen anschauen
•	 Mittels Cursor den entsprechenden 

Speichernamen auswählen

•	 ENTER Taste drücken und gedrückt 
halten

•	 Die gespeicherte Messung wird 
angezeigt.

Zugleich wird das kleine Viereck der zuletzt 
angeschauten Speicherposition gefüllt. 
Dieses Viereck ist die Markierung für die 
„Schnellrückruffunktion”.

Viereck
Schnellrückruf Funktion (nur ML1)
Nach dem Verlassen der Speicherübersicht 
kann der zuvor markierte Speicherplatz 
jederzeit durch drücken (und halten) von 
ESC + ENTER angezeigt werden. Dies ist 
sehr nützlich, wenn z.B. Terzspektren vor 
bzw. nach einer geänderten Einstellung 
verglichen werden sollen.
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Einzelne Messungen löschen
Jede gespeicherte Messung kann einzeln 
gelöscht werden.
•	 Wählen Sie das „DEL“ Feld neben der 

zu löschenden Messung aus

•	 ENTER Taste drücken

•	 Sicherheitsabfrage mit „OK“ bestätigen

•	 Die Messung wird gelöscht aus dem 
Messgerätespeicher

Gesamter Speicher löschen
Der komplette Speicher kann durch das 
Feld „DEL ALL“ gelöscht werden.

Verlassen der Speicherübersicht
2 x ESC bzw. EXIT drücken

Startbildschirm
Wird beim Erscheinen des Startbildschirms 
eine Taste gedrückt, so bleibt die Anzeige 
so lange stehen, bis die Taste wieder losge-
lassen wird. Dies unterstützt z.B. das einfa-
che  Abschreiben der Geräteseriennummer 
(z.B. ANK675A0A2).

Nach erfolgter Registrierung Ihres Mess-
gerätes können Sie den Startbildschirm 
personalisieren. Siehe hierzu Details im 
Kapitel „Personalisieren der Startanzeige“.
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Stromsparfunktionen

Während der ML1/DL1 mit dem PC 
verbunden ist und die MiniLINK PC 
Software läuft wird das Messgerät vom 
PC elektrisch versorgt. Die folgenden 
Stromsparfunktionen werden dabei 
deaktiviert:

•	 Automatisches Abschalten des ML1/
DL1 („Auto Power Off”).

•	 Automatisches Ausschalten der 
Hintergrundbeleuchtung („Auto Light 
Off”).

Nach dem Schliessen der PC Software 
MiniLINK wird der ML1/DL1 weiter von 
der PC Versorgungsspannung betrieben, 
jedoch die Stromsparfunktionen sind 
wieder aktiviert.

Batterieanzeige

Falls die Batterien leer werden blinkt das 
„Batterie leer“ Symbol anstatt der MEM 
Anzeige in der Menüauswahl.



20

4.	 Minilyzer ML1 spezifische Features
Dieses Kapitel beschreibt alle neuen Minilyzer ML1 spezifischen Features.

Loggen von SPL und LEQ Werten

Hinweis: 	 Das Loggen von SPL/LEQ Werten ist ein gratis Zusatzpaket 
zum MiniLINK, das erst nach der Registrierung des Gerätes 
freigeschaltet wird.

Zur Dokumentation der Schallpegelmessung, z.B. während einer 
Veranstaltung,  kann der ML1 den SPL/LEQ Verlauf über mehrere Stunden 
abspeichern. Diese gespeicherten Messwerte können mit Hilfe der 
MiniLINK PC Software aus dem Minilyzer gelesen und z.B. in Microsoft 
Excel in ein aussagekräftiges Pegeldiagramm umgewandelt werden.

Die aufgezeichneten Messwerte bleiben auch dann im Speicher erhalten, 
falls während der Aufzeichnung die Batterien leer werden.

Start SPL/LEQ Logging
Sobald die Loggingfunktion freigeschaltet 
ist, erscheint im „MEM“ Menü der „Level 
SPL“ Messfunktion der zusätzliche Eintrag 
„LOG AS ...“. Damit lassen sich folgende 
Messwerte speichern:

•	 Aktueller LEQ und SPL Wert

•	 LEQ Übersteuerung

•	 Für jedes Aufzeichnungsintervall: 
SPL Mittelwert, Minimum und Maximum
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Einstellung der Messzeit

Die maximal Messzeit (END) zur Schall-
pegeldatenaufzeichnung hängt vom freien 
Messgerätespeicher und der gewählten 
Messintervalldauer (T) ab. Der Logger kann 
bis zu 1500 Messpunkte aufnehmen.

Die Intervalldauer T, in der die Messwerte 
gespeichert werden, ist im Format  
(hh:mm:ss) frei wählbar.

Speicheransicht der Pegelmessung
Im Speichermenü wird bei der Ansicht 
der gespeicherten SPL/LEQ Messung, 
das nebenstehende Bild angezeigt. Die 
einzelnen Messdaten sind bei diesem 
Speicherplatz hinterlegt und können am PC 
ausgelesen werden.

Achtung:	 Während der Logger aktiv ist, kann am ML1 keine 
Einstellung verändert werden, welche die laufende 
Messung beeinflussen könnte.
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SPL/LEQ Filter

Schallpegelmessungen werden im An- 
wendungsbereich des ML1 fast aus-
schliesslich A-gewichtet durchgeführt.  Zur 
Vermeidung falscher  Filtereinstellungen 
wird die A-gewichtung (A-WTD) automa-
tisch bei jedem Aufruf der LEVEL -> SPL 
Messfunktion aktiviert.

Achtung:	 Der A-Gewichtungsfilter ist bei jeder neuen Anwahl der 
LEVEL SPL Funktion als Grundeinstellung vorgewählt.

„Flat” Filter

Die Filterbezeichnung „Linear“ wurde durch 
den englisch korrekten Ausdruck „Flat“ 
ersetzt. Bei dieser Einstellung wird das 
Messsignal nicht gefiltert.

THD+N, k2 - k5

Die THD+N Funktion misst die 2., 3., 4. & 5. 
harmonische Verzerrung. Das jeweilige 
Messergebnis kann unter dem grossen 
THD+N Messresultat selektiert werden.
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Polaritätsmessfunktion

Mit der Messfunktion „Polarity“ kann in Kombination mit dem Minirator MR1 
die korrekte Beschaltung von Kabeln und Lautsprechersystemen getestet 
werden. Der ML1 bietet dazu verschiedene Möglichkeiten.

a. Polaritätsmessung an Lautsprechern

Das MR1 Polaritätstestsignal wird in das 
Lautsprechersystem eingespeist und ist 
akustisch gut hörbar.

Einstellungen am Minilyzer:

•	 IN:MIC (INT), bei Verwendung des 
internen Mikrophons

•	 IN:XLR/RCA, bei Verwendung eines 
externen Mikrophons, z.B. MiniSPL

Wählen Sie nun den Frequenzbereich für 
den Polaritätstest:

•	 FULL/MID, für Messungen an 
Breitbandlautsprechern

•	 WOOFER, für Basslautsprecher

Achtung: 	 Bitte beachten Sie, dass die Polarität eine starke Verein-
fachung eines recht komplexen Phasenzusammenhanges 
ist. Sowohl Lautsprecher als auch Frequenzweichen fügen 
einem Signal z.T. sehr starke Phasenverzerrungen zu.

 
Die Polarität der einzelnen Lautsprecher in Boxensystemen 
kann durchaus unterschiedlich sein. Dies ist weder ein 
Fehler noch ein  Zeichen für ein schlechtes Boxendesign.

	 Polaritätsmessungen machen dann Sinn, wenn die 
korrekte Verkabelung gleichartiger Lautsprechersysteme 
verglichen werden soll.
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b. Polaritätsmessung von Kabeln

Das Minirator-Polaritätstestsignal wird 
in das zu testende Kabel eingespeist. 
Der Minilyzer analysiert die Polarität am 
anderen Kabelende.

Einstellung am Minilyzer:

•	 IN: XLR/RCA, 

•	 Mode: Cable

Folgende Fehlerquellen können einfach 
und schnell lokalisiert werden:

•	 Falsche Polarität, verursacht 
durch  fehlerhafte Verbindungen im 
Kabelinnern

•	 Kabelprobleme
	 Die Signalsymmetrie (Balance) kann auf 

verschieden Kabelprobleme hinweisen, 
wie z.B.:

-	 „–UBAL–“ deutet auf eine 
unterbrochene Leitung bei einem 
symmetrischen (XLR) Kabel.

-	 Anzeigepfeil nicht mittig deutet auf 
sonstige Kabelprobleme, siehe hier-
zu das NTi Audio  Dokument „Balan-
ce application note“, verfügbar als 
download auf der NTi Audio  Websei-
te.

 
Die Pegelanzeige gibt für trickreiche-
re Anwendungen (z.B. Testen von 
Multicorekabel) weitere Informatio-
nen über die Kabelbeschaffenheit.
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Messung von Induktionsschleifen

Der Minilyzer vereinfacht die Einstellung und Überprüfung von AFILS 
(=Audio Frequency Induction Loop Systems). AFIL Systeme werden 
zur besseren Sprachverständlichkeit für Hörgeräteträger in öffentlichen 
Gebäuden eingesetzt. 
Die meisten Hörgeräte beinhalten eine magnetische Spule, welche von der 
Induktionsschleife erzeugte Audiosignale empfangen kann. AFILS Systeme 
bestehen aus einer Drahtschleife und einem Stromverstärker. Das erzeugte 
magnetische Feld wird durch ein Eingangssignal, z.B. Stimme, moduliert. 

Die Einstellung und Verifikation von AFIL Anlagen ist im IEC60118 
Standart beschrieben. Der Minilyzer, zusammen mit einem Induktions- 
schleifensensor, ist ein ideales Messwerkzeug für AFIL System-
messungen.

Induktionsschleifenaufnehmer
Induktionsschleifenaufnehmer sind von verschiedenen Herstellern  
erhältlich. Alle bislang bekannten Modelle funktionieren mit dem ML1. 
Einige haben ein A-Gewichtungsfilter eingebaut, dieser sollte jedoch zur 
Vermeidung von  Messfehlern ausgeschaltet werden.

Induktionsschleifenmode starten

•	 ML1 SETUP Menü öffnen 

•	 „Ind. loop mode” auf „ENABLE” setzen

•	 ESC Taste drücken

Der ML1 startet daraufhin automatisch 
im Induktionsschleifenmode. Um diesen 
Mode wieder zu verlassen ändern Sie den 
entsprechenden Eintrag im Setup Menü.
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Messfunktionen für Induktionsschleifensysteme

Der Minilyzer startet mit einem speziellen 
Messmenü für Messanwendungen bei 
Induktionsschleifenanlagen.

•	 Level Fast, schnelle Zeitgewichtung

•	 Level Slow, langsame Zeitgewichtung

•	 Level PPM

•	 THD+N

•	 F-Sweep, Frequenzgang

•	 1/3rd Oct, Spektrumanalyzer

•	 Scope, Oszilloskop

•	 Calibrate, Kalibration

Einheiten mA/m, dBL
Die magnetische Feldstärke wird in A/m (Ampere pro Meter) gemessen. 
AFILS Anlagen verwenden 400 mA/m als Referenzpegel. Die logarithmische 
Einheit der magnetischen Feldstärke ist dBL (dB Loop) und hat einen 
Referenzpegel von 400 mA/m:

		

  Magn. Feldstärke

       400mA/m
dBL1	 = 20 * log  

1  Die Einheit dBL ist neu und noch nicht standardisiert, resultiert jedoch aus 
der Diskussion mit den IEC 60118 Komiteemitgliedern.

Kalibration

Ein Induktionsschleifensensor transformiert 
die magnetische Feldstärke in einen 
elektrischen Pegel. Die Sensorsensitivität 
wird in den technischen Daten angegeben. 
Diese Sensitivität muss am Minilyzer vor 
der ersten Messung eingestellt werden.
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Filter

Der Minilyzer hat einen A-Gewichtungsfilter 
und einen HP400 Filter (Hochpass 
400Hz) inkludiert. Der Standard IEC60118 
spezifiziert die jeweils benötigten 
Filtereinstellungen. 
Der HP400 Filter hat eine gute Dämpfung von 
störenden Netzspannungskomponenten, 
welche oft eine dominierende Rolle 
gegenüber dem Nutzsignal bei Induktions- 
schleifensystemen einnehmen kann.

 
Logging
Die folgenden Funktionen unterstützen das Auslesen der Messergebnisse 
in numerischen Werten: THD+N, FSweep, 1/3rd Octave.

 
Level Fast, Level Slow

Der Pegel der magnetischen Feldstärke 
wird nach IEC60804 (Schallpegelmessung) 
mit den folgenden Zeitgewichtungen 
gemessen:

•	 Level Fast: 	 125ms

•	 Level Slow:	 1s

Level PPM

Feldstärkepegel gemessen mit einer ppm 
(Typ IIa) ähnlichen Spitzenwertdetektor.

•	 Integrationszeit:10 ms.

•	 dBLp = dB Loop peak
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THD+N

Gesamte harmonische Störungen und 
Rauschen.
Die Werte THD+N und Level RMS werden 
angezeigt.

Für Detailinformationen siehe Anleitung 
„Minilyzer ML1“.

FSweep

Messung des Frequenzgangs

Für Detailinformationen siehe Anleitung 
„Minilyzer ML1“.
Bei dominanten Netzspannungsstörungen, 
funktioniert die Frequenzgangsmessung 
nur mit der Vorwahl des HP400 Filters.

1/3rd Octave

1/3 Oktavbandspektrum
Diese Messfunktion misst das Spektrum des 
Eingangssignals. Für Detailinformationen 
siehe Anleitung „Minilyzer ML1“.

Die Messbereichseinstellung wird für 
AFIL Messungen nicht benötigt und zur 
Vereinfachung deshalb nicht angezeigt.

Scope

Zeitliche Anzeige des Eingangssignals
Für Detailinformationen siehe Anleitung 
„Minilyzer ML1“.
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5.	 Digilyzer DL1 spezifische Features
Beginnend mit der Firmware D2.00 beinhaltet der Digilyzer DL1 die 
im Kapitel „Neue Firmware für ML1 & DL1” bereits beschriebenen 
Funktionen:

•	 Speichern von Screenshots und Messdaten

•	 Online loggen

•	 Personalisieren von Startanzeige

Event Logger

Der Digilyzer unterstützt, beginnend mit der Firmware D2.10, den Transfer 
aller numerischer Event Logger Daten vom Messgerät auf den PC.
Die DL1 spezifische Anzeigemaske hat hierbei keinen Einfluss, d.h. dass 
immer alle Event Logger Messdaten abgespeichert werden.
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6.	 MiniLINK PC Software
Die MiniLINK PC Software ermöglicht den Transfer der gespeicherten und 
aktuellen Messdaten vom Messgerät zum PC.

Verbinden Sie hierzu Ihr Messgerät und den PC mit dem USB Kabel und 
starten die MiniLINK Software. Die folgende Anzeige wird sichtbar:

Versorgt durch die USB Schnittstelle schaltet sich das Messgerät selbst 
ein. Während des Betriebs über die USB Schnittstelle werden die Batterien 
nicht mehr entladen, jedoch dürfen diese auch nicht entfernt werden.
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Messgerätedaten auslesen

Der Speicherinhalt des ML1/DL1 wird automatisch zum PC übertragen und 
im MiniLINK Anzeigefenster graphisch dargestellt.

Achtung:	 Falls keine Messdaten gelesen werden ist der Messgerä-
tespeicher leer. Klicken Sie mit der PC-Maus auf das „ML1 
Memory“ Feld zur Aktualisierung des Anzeigefensters.

Die Messdatenanzeige am PC ist synchron und identisch zum 
angesteckten Minilyzer. Die Geräteseriennummer und die Firmwareversion 
des angeschlossenen Messgerätes wird in der Überschrift angezeigt. 

synchronisierte AnzeigeMiniLINK PC 
Software Version

Firmware des 
angeschlossenen 

Messgerätes

Seriennummer des 
angeschlossenen 

Messgerätes
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Visualisierung der gelesenen Messdaten

Alle im Messgerät  gespeicherten Screenshots werden gleichzeitig im 
MiniLINK Anzeigefenster „ML1 Memory“ angezeigt. 

Vergrößern der Messdatenanzeige
Beim Doppelklicken auf ein Speicherbild 
wird dieses vergrößert. Das direkte Drucken, 
Speichern und Kopieren der Screenshots 
und der numerischen Testresultate wird 
hierin unterstützt.
Verfügbare numerische Messwerte werden 
immer zusätzlich unter dem Screenshot 
angezeigt.

Kopieren der Messdaten

Die angezeigten Screenshots bzw. Mess-
werte können direkt zur Dokumentation in 
Testberichte kopiert werden.

•	 Wähle das Menü „Edit -> Copy Bitmap” 
zur Bildauswahl oder das Menü “Edit -> 
Copy Text” zur Messdatenauswahl.

•	 Kopiere die Daten in das gewünschte 
Dokument mit „Ctrl + V”, z.B. Excel,...

Alternativ kann das mit den Messdaten 
gespeicherte „*.txt” File  über den Text- 
konvertierungsassistent z.B. in Microsoft 
Excel importiert werden.

Bei 1/3rd Oct. Messungen werden zusätz-
lich die numerischen Messdaten unter der 
Minilyzeransicht angezeigt.

•	 1/3 Oktave Frequenz

•	 Messpegel
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Zusätzliche Anzeigen beim Minilyzer ML1:

•	 Geloggte Schallpegelmessungen werden mit „SPL/LEQ LOG DATA“ 
angezeigt. Die detaillierten Messdaten sind bei diesem Bild hinterlegt 
und können durch einen Doppelklick auf dieses Bild angezeigt werden.

•	 TimeSweep Messung: der Minilyzer kann wie gehabt eine TimeSweep 
Messung aufnehmen und die einzelnen Messdaten sind beim Bildsymbol 
„TIMESWEEP DATA“ hinterlegt. Da es sich hierbei um einen separaten 
Speicher handelt, wird das Bild immer als letztes und in einer anderen 
Farbe angezeigt.

SPL/LEQ LOG Daten TIMESWEEP Daten

Die Pfeile weisen auf die 
zusätzlichen gespeicherten 
numerischen Messdaten mit 
diesem Screenshot hin.
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Beispiel: Anzeige SPL/LEQ  Logging

Die SPL/LEQ Logging 
Funktion speichert die 
folgenden Messwerte 
ab (konform zum 
Loggen mit der 
Firmware):

•	 Messeinstellungen

•	 Zeit, relativ zum 
Startzeitpunkt der 
Aufzeichnung

•	 Aktueller LEQ und 
SPL

•	 Für jedes 
Aufzeichnungs-
intervall: 
SPL Mittelwert, 
Minimum und 
Maximum

•	 LEQ Übersteuerung
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Beispiel: Anzeige der TimeSweep Messdaten

Bei den zeitlichen Messdatenaufnahme werden die folgenden Daten 
ausgelesen:

•	 Messeinstellungen

•	 Zeit, relativ zum Startzeitpunkt der Aufzeichnung

•	 THD, aktuell, min. & max. des Zeitintervalls

•	 Messpegel, aktuell, min. & max. des Zeitintervalls

•	 Frequenz, aktuell, min. & max. des Zeitintervalls
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Zusätzliche Anzeigen beim Digilyzer DL1:

Die im Digilyzer gespeicherten Eventlogger Messdaten werden mittels  
„EVENT LOG DATA“ angezeigt. Die detaillierten Messdaten sind bei 
diesem Bild hinterlegt und können durch einen Doppelklick auf dieses Bild 
angezeigt werden. Da es sich hierbei um einen separaten Speicher handelt, 
wird das Bild immer als letztes und in einer anderen Farbe angezeigt.

EVENT LOGGER Daten

Die Pfeile weisen auf die 
zusätzlichen gespeicherten 
numerischen Messdaten mit 
diesem Screenshot hin.



37

Beispiel: Anzeige der Event Logger Messdaten

Bei den Event Logger Messdatenaufnahme werden die folgenden Daten 
ausgelesen:

•	 Messeinstellungen

•	 Zeit, relativ zum Startzeitpunkt der Aufzeichnung

•	 Ereigniszähler, Anzahl der Irregularitäten des digitalen 
Eingangssignals während jedem einzelnen Speicherintervall

•	 Ereignisgruppe, Anzeige der Ereigniskategorie

•	 Ereignis, exakte Beschreibung des aufgezeichneten Ereignisses

•	 Info, detaillierte Auflistung der Anzahl dieser Ereignisse am Kanal A 
und B 
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Messdaten speichern

Die angezeigten Screenshots können als Bitmapdateien (*.bmp)  und 
zusätzliche verfügbare numerische Messdaten gleichzeitig als Textfile (*.txt) 
gespeichert werden. Als Fileformat werden durch Leerzeichen getrennte 
Messwerte mit „.“ als Dezimaltrennzeichen verwendet. Der Speichername 
besteht aus den ersten sechs Stellen der ML1/DL1 Seriennummer und 
dem Screenshotnamen.

Zum Beispiel der Screenshot „M011_FSWEEP”, abgespeichert von einem 
Minilyzer S/N ANK675, wird am PC gespeichert als „ANK675_M011_
FSWEEP.bmp” und „ANK675_M011_FSWEEP.txt”.

Somit können verschiedene Messresultate von mehreren Messgeräten am 
gleichen PC abgespeichert werden.

•	 Zu speichernde Messdatenbilder im Memoryfeld auswählen

•	 Mittels PC-Maus auf SAVE bzw. im Menü File -> SAVE klicken

•	 Das Speicherauswahlmenü wird angezeigt. Der Pfadname kann sich 
laut dem installierten Windows-System unterscheiden
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Während des Speichervorganges am PC können dieselben Messdaten 
auf dem Messgerät automatisch gelöscht werden. Die entsprechenden 
Einstellungen sind im angezeigten Menü auszuwählen, z.B. „Delete files in 
instrument memory after save”.

Messgerätespeicher löschen

Die am Messgerät gespeicherten Messungen können wie folgt gelöscht 
werden:

•	 Direkt im Messgerät in der Speicherübersicht

•	 Den Screenshot in der MiniLINK Anzeige wählen und mit der DEL 
Taste auf der PC Tastatur löschen

•	 Mittels Edit -> Delete im MiniLINK Memory Menü

•	 Beim gleichzeitigen Abspeichern am Computer

Messdatenerfassung auf dem PC

MiniLINK unterstützt zusätzlich die fortlaufende zeitliche Messdaten-
speicherung. Die aktuellen Messwerte der Funktionen
	

Minilyzer ML1 Digilyzer DL1
• Level RMS, REL, SPL
• THD+N, vu + PPM
• Balance

• Bitstatistic
• Level RMS, Level Peak
• THD+N

können in beliebigen zeitlichen Intervallen protokolliert werden. Die 
geloggten Messdaten werden direkt in die MiniLINK Software geschrieben. 
Die „Save“ Funktion speichert die Messdaten als ASCII File auf die 
Festplatte. Der gespeicherte Datenfilename ist z.B. „ANK675_PcLog_Level 
SPL”. 
Die Funktion eignet sich hervorragend für Langzeitüberwachungen z.B. im 
Labor oder in rundfunktechnischen Anwendungen
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Symbol für direktes kopieren 
der aktuellen Anzeige

Führen Sie die folgenden Schritte aus:

•	 Gewünschte zu loggende Messfunktion wählen

•	 Selektieren Sie die Registerkarte „Logging“ in der PC Software 

•	 Gewünschtes zeitliches Loggingintervall aus Liste auswählen

•	 Startknopf drücken und die Aufzeichnung beginnt

•	 Zur Beendigung der Aufzeichnung Stop drücken

•	 Mit SAVE wird das Messergebnis abgespeichert

Zusätzlich kann der aktuelle, auf der MiniLINK PC Software angezeigte 
Screenshot, direkt in ein Dokumentationsfile kopiert werden. Mittels 
Mausklick auf das markierte Symbol wird die aktuelle Anzeige eingelesen 
und im gewünschten File mit „CTRL + V” eingefügt.
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Messgerätesteuerung über PC

Das Messgerät kann direkt per Maus oder PC Tastatur gesteuert werden. 
Klicken Sie zuerst auf das Messgerät am PC, und schon kann mittels der 
PC-Tastatur bzw. den Minilyzerpfeiltasten am PC das Messgerät über die 
USB Schnittstelle fernbedient werden.

    
		         			 

           

Pfeiltasten & Enter

Licht: Ctrl + LESC

Ein/Aus: Ctrl + P

•	 „Shift <-” oder „shift ->” führt ein Wechsel zwischen den 
Messgeräteanzeigen einer Messfunktion durch.

Klicke auf diese 
Felder um den 
Anzeigemodus zu 
wechseln 
(e.g. SPL ↔ RTA)
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MiniLINK Tools

Die MiniLINK PC Software stellt die folgenden Werkzeuge zur Verfügung

•	 LCD Fullscreen

•	 Update Firmware

•	 Crossgrade Firmware

•	 StartUp Screen
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Grossanzeige der Messresultate am PC

Die aktuelle Messgeräteanzeige kann am PC Bildschirm in voller Grösse 
dargestellt werden:

•	 Wähle das Menü „Tools -> FullScreen“ in der MiniLINK Software

•	 Die Grossanzeige wird durch einen Mausklick oder der „Q” Taste 
wieder verlassen.

Alternativ durch das Symbol links oben am virtuellen Messgerät kann die 
Messgeräteanzeige auf volle Bildschirmgröße gebracht werden. Dies ist für 
Schulungs- und Trainingszwecke sehr nützlich.

Symbol für 
Grossanzeige
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Firmware aktualisieren

NTi Audio stellt auf der Webseite sowohl Updates der PC-Software als auch 
der Messgerätefirmware bereit. 

Sie können den Stand Ihrer Software/Firmware wie folgt überprüfen:
•	 Verbinden Sie Ihren PC zum Web
•	 Starten Sie die MiniLINK PC Software
•	 Messgerät mittels USB Kabel zum PC verbinden
•	 Wählen Sie das Menü „Help -> Look for Updates“ 
•	 Alle notwendigen Detailinstruktionen werden nun angezeigt

Alternativ können Sie die aktuellen Versionen ohne Messgerät von der 
folgenden NTi Audio Webseite herunterladen:
“http://registration.nti-audio.com/VersionCheck.php”.

•	 Wähle das Menü “Tools -> Update Firmware“ 

Selektieren Sie im folgenden Fenster die Firmwareversion

für Minilyzer ML1:
ML1dA_V3.xx.bin

für Digilyzer:
DL1dA_D2.xx.bin

die verfügbare 
Firmware für das 
angeschlossene 
Messgerät wird 
angezeigt

Nach Bestätigung der Gerätefirmwareversion wird das angeschlossene 
Messgerät aktualisiert.

Hinweis:	 Beim Laden der neuen Firmware wird der interne 
Messgerätespeicher gelöscht. Tritt während des 
Aktualisierens der Firmware ein Fehler auf (z.B. Stromausfall), 
so kann der Vorgang jederzeit wiederholt werden.

http://registration.nti-audio.com/VersionCheck.php
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Firmware Crossgrade

Der Acoustilyzer AL1 und der Minilyzer basieren auf der gleichen Hardware- 
Plattform mit unterschiedlicher installierter Firmware. Das verfügbare  
ML1 - AL1 Crossgrade Produkt ermöglicht eine Installation der ML1 
Firmware auf den AL1 oder eine Installation der AL1 Firmware auf den 
ML1. Die Crossgrade - Funktionalität ist nach der Installation der Option 
„ML1-AL1 Crossgrade“ verfügbar.

Achtung: Beim Laden der Crossgrade Firmware wird der interne 
Messgerätespeicher gelöscht, somit muss die personalisierte 
Startanzeige neu in das Messgerät geladen werden.

Personalisieren der Startanzeige

Die MiniLINK PC Software kann ein kundenspezifisches Bild auf das 
Messgerät überspielen, das beim Einschalten des Gerätes anstatt dem 
Produkt-Logo angezeigt wird.
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Öffnen Sie das „Set Startup Screen“ Fenster mittels dem Menüpunkt „Tools 
-> StartupScreen“. Im „Set Startup Screen” Feld wird die Herstellergrund
einstellung angezeigt.  Der weisse mittlere Teil (100 x 32 Pixel) kann vom 
Kunden verändert werden. Der restliche obere und untere graue Bereich 
ist fixiert.

Vorschlag für die Abspeicherung einer neuen Startanzeige:

•	 Ein vordefiniertes Bild verwenden: Die MiniLINK PC Software 
konvertiert dieses automatisch auf eine Grösse von 100x32 Pixel und 
zu einem Schwarz/Weissbild. Die folgende Formate können direkt als 
Startanzeige verwendet werden: *.pcx;*.bmp;*.dic;*.rle;*.ico;*.wmf.

•	 Ansonsten können Sie selbst ein neues Startbild in einem Bild-
bearbeitungsprogramm, z.B. MS Paint, erzeugen. Setzen Sie die 
Bildgröße auf 100x32 Pixel und füllen es mit dem gewünschten Inhalt 
(Bilder bzw. Text). Dann das neue Bild bitte als *.bmp* abspeichern.

•	 Mit „Load Image” die gewünschte neue Anzeige in die MiniLINK PC 
Software laden.

•	 Die Vorschau der neuen Startanzeige wird angezeigt.

•	 „Send to Device” wählen um die neue Startanzeige zum Messgerät zu 
senden.

•	 Das Messgerät schaltet nun automatisch aus und wieder ein. Der neue 
Startbildschirm wird angezeigt.

Beispielanzeigen:
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7.	 Problemlösungen

a. Import von numerischen Messdatenfiles „*.txt” nach Excel

Problem:
Die Zahlen werden beim Import nach Excel nur als Text erkannt, somit 
können keine Tabellen bzw. weitere Kalkulationen ausgeführt werden.

Lösung:
Die MiniLINK Messdaten werden durch Leerzeichen getrennt und mit „.“ als 
Dezimaltrennzeichen abgespeichert. Deshalb muss beim Import der Daten 
nach Excel das Dezimaltrennzeichen auf „.” gesetzt werden.
Alternativ können Sie bei der vergrösserten Messdatenanzeige mittels dem 
Menüpunkt „Edit -> Copy Text” die Messdaten direkt in ein offenes Excel 
Arbeitsblatt einfügen.

b. Registrierung

Problem:
Die Registrierung Ihres Messgerätes funktioniert nicht.

Lösung:
Prüfen Sie die letzte aktuelle Firmware und PC Software Version auf der 
NTi Audio Webseite „http://registration.nti-audio.com/VersionCheck.php”.

Falls Sie nicht die Aktuellsten verwenden bitte die neuen verfügbaren 
Versionen vom Web laden. Probieren Sie danach die Registrierung 
nochmals.

http://registration.nti-audio.com/VersionCheck.php
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